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Chapter 1 — General Information

1-1 Introduction
The MA8100A TRX NEON Signal Mapper is a 3D in-building coverage mapping solution that 
is integrated for use with Anritsu handheld spectrum analyzer products to automatically 
collect geo-referenced test data with every step. The system allows you to perform coverage 
testing of RF communications systems both indoors and outdoors. It uses inertial data from a 
wearable tracking device to enable real-time 3D location and mapping inside buildings. The 
system incorporates GPS data when line of sight to GPS satellites is available.

1-2 Contacting Anritsu for Sales and Service
To contact Anritsu, visit the following URL and select the services in your region:
http://www.anritsu.com/contact-us.

1-3 System Overview
The MA8100A consists of the following software and hardware.

• TRX System NEON Signal Mapper Software for Android phone or tablet

• TRX System NEON Command Software for a Windows-based PC or laptop

• TRX System NEON Tracking Unit with micro USB cable for charging the battery

• TRX System NEON Cloud Service

• USB OTG Cable

• Android Device (user provided)

• TP-Link TL-WR802N travel router (user provided, optional)

• Anritsu Spectrum Analyzer or Anritsu Remote Spectrum Monitor (user provided)

• PC or Laptop (user provided)

NEON Signal Mapper

The NEON Signal Mapper provides the Android user interface to test signal coverage and to 
create heat maps. RF data is captured by an Anritsu Handheld Spectrum Analyzer and sent 
to the Android device, typically via a USB connection. Users can edit building data, initialize 
their location, start and stop the recording of signal data, and upload mapping data to the 
NEON Cloud. 

http://www.anritsu.com/contact-us
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NEON Command

The NEON Command is a PC-based map editing and tracking software that enables the 
creation and visualization of 3D building maps. The user can create building outlines, add 
floor plans, and generate heat maps of geo-referenced measurement results. The file export 
feature lets you generate reports of the signal map data. NEON Command also provides 
access to the NEON Cloud Service to store and retrieve maps and measurement data.

NEON Tracking Unit

The NEON Tracking Unit shown in Figure 1-1 It is a wearable accessory that can be clasped 
to a belt. The tracking unit is paired with an Android device and used to collect and process 
location data. The location data is sent over Bluetooth to the NEON Signal Mapper 
application running on an Android phone or tablet.

A micro USB cable is provided for recharging the NEON tracking unit battery. 

LED Indicators

The NEON Tracking Unit has two LEDs to indicate device status. The top LED indicates the 
accessory’s operating mode. The bottom LED indicates the charging status.

Operation LED (Top)

• Off – Tracking Unit is powered off

• Solid green – Starting up or powering down

• Blinking green – Anchor mode: device is on but not connected to the Signal Mapper app

• Blinking blue – Tracker mode, connected to NEON

• Blinking orange – Tracker mode, not connected to NEON

• Blinking purple – Bootloader starting or download in progress

• Solid purple – Bootloader Ready

• Solid green – Bootloader Success

1. Operating Mode LED

2. Power Button

3. Charge Status LED

Figure 1-1. NEON Tracking Unit

2

1

3
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Charging LED (Bottom)

• Solid orange – Charging

• Solid green – Charged

• Off – USB is disconnected

• Blinking green/orange – Charging error

On/Off Procedure

Press the Tracking Unit power button to turn on the device. The top LED is solid green while 
the unit is powering on. It blinks green when power-on is complete and the Tracker is not yet 
connected to the Signal Mapper application (Anchor mode).

To turn off the Tracking Unit, press and hold the power button for at least a half-second. The 
top LED is solid green while the unit is powering down and turns off when power down is 
complete.

Calibration

The NEON Tracking Unit requires no user calibration. The magnetometer and gyroscope 
within the device automatically calibrates while the user moves and stops.

NEON Cloud Service

Signal map logs containing measurement results with location information for the signals 
that were detected and geo-referenced are uploaded to the NEON Cloud, where they are 
accessible to users registered under the same NEON subscription.

Building data is also uploaded to the cloud when saved, except for offline buildings. Refer to 
“Offline Buildings (Optional Feature)”. You can download building updates made by other 
users by synchronizing NEON Command or Signal Mapper with the cloud.

Android Devices

See the suggested recommended systems requirements and Android devices at the TRX 
NEON website: https://docs.trxsystems.com/signal-mapper/

https://docs.trxsystems.com/signal-mapper/
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Spectrum Analyzers

The Anritsu’s handheld spectrum analyzer products are used with NEON MA8100A to 
perform coverage mapping of RF signal data inside buildings, where GPS is not available. 
The NEON MA8100A Signal Mapper is compatible with the following Anritsu handheld 
models listed in Table 1-1. For information using the Anritsu handheld spectrum analyzers, 
antennas, and accessories, search our product pages at https://www.anritsu.com

Figure 1-2 shows a sample of the Anritsu handheld products used with TRX NEON MA8100A 
to perform coverage mapping. 

Table 1-1. Compatible Spectrum Analyzers

Product family Handheld Models

BTS Master MT8220T 

Cell Master MT8213E

Field Master Pro MS2090A

LMR Master S412E

Remote Spectrum Monitor MS27101A-IBCM

Site Master
S332E
S362E

Spectrum Analyzers/
Spectrum Master

MS2711E
MS2712E
MS2713E
MS2720T

VNA Master

MS2034B
MS2035B
MS2036C
MS2037C
MS2038C

Figure 1-2. Handheld Spectrum Analyzers Family (User Provided)

https://www.anritsu.com
https://www.anritsu.com
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Chapter 2 — Installing TRX NEON

2-1 Introduction
In-building coverage mapping of RF data captured with an Anritsu Handheld Spectrum 
Analyzer requires the use of a TRX NEON software, PC, and an Android smart phone or 
tablet. The Anritsu spectrum analyzer, Android device and PC are not included and must be 
provided by the user. The TRX systems NEON Command, NEON Personnel Tracker, and 
NEON Signal Mapper are downloaded from the TRX Systems website. 
https://docs.trxsystems.com/

2-2 Registration and Installation
A NEON account is required to log in to the website to log in and register. To obtain details on 
how to create a NEON account, go to: https://docs.trxsystems.com/subscription/

Once registered, see the NEON Signal Mapper Quick Start Guide and follow the instructions 
provided: https://docs.trxsystems.com/quick-start/

The Quick Start Guide also provides instructions for:

• Site Planning 

• On-Site Signal Mapping (Android)

• Generate Heat Map (PC)

• View Location Data (PC)

2-3 NEON Command System Requirements
Follow the instructions provided to register for NEON and to install the software. Review the 
PC and Android requirements before installing. NEON Command is installed on a PC that 
will serve as a Command Station. While NEON Signal Mapper is an Android app. the 
maximum number of licensed Command Stations and Android devices depends on the 
MA8100A TRX NEON Signal Mapper subscription that your company purchased. 

https://docs.trxsystems.com/
https://docs.trxsystems.com/subscription/
https://docs.trxsystems.com/quick-start/
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2-4 NEON Signal Mapper Software
After registration, you will receive an email with the subject line “Welcome to NEON!” 
inviting you to join your company’s NEON subscription. Click the Register for NEON button in 
the email and create your login account as described in “NEON Signal Mapper Software” 
on page 2-2.

Proceed with the steps below after you have registered for a login account.

1. Open a Web browser on your Android device and go to https://neon.trxsystems.com.

2. Log in to your NEON account.

3. On the Downloads page, tap the NEON Signal Mapper button. 

4. Install the Signal Mapper application by tapping the file from the drop-down 
notification bar. You can also install the app from the Downloads folder on your 
Android device.

Software Update

Registered users should receive an email from TRX Systems announcing a new software 
version when one becomes available. Click on the included link to open the login page and you 
will be directed to the NEON Downloads page.

Alternatively, you can simply open the application and a prompt will display, asking whether 
you wish to update. Follow the screen prompts to update to the latest version.

With no update notification, you can still look for the latest versions of NEON Command and 
NEON Signal Mapper by logging in to the Downloads page. If you already have NEON 
Command open on your PC, click the Help menu and select Check for Updates. On your 
Android device, tap the Signal Mapper menu button and select Check for Updates.

https://neon.trxsystems.com
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2-5 Hardware Connections
The MA8100A TRX NEON Signal Mapper with spectrum analyzer is composed of the 
hardware items shown in Figure 2-1 and Figure 2-2 on page 2-4. Here, an Anritsu LMR 
Master (S412E) is the handheld instrument shown connected to the Android device. 

Use the USB OTG cable to connect the Anritsu spectrum analyzer to the Android device. The 
Laptop or PC is used for creating building models, importing floor plans, and remote 
monitoring. No hardware connection is required. The NEON Tracker is a wearable remote 
device that has a clip that can be used to clasp onto a user’s belt. 

Refer to the In-Building Coverage Mapper Hardware Installation Guide (10580-00470) for 
complete MS27101A-IBCM power-on and assembly instructions.

The NEON Tracker, Software and Android device are supplied by the user.

1. Anritsu Spectrum Analyzer (S412E)

2. Laptop or PC

3. Android Device

4. USB OTG Cable

5. NEON Tracker

Figure 2-1. Spectrum Analyzer Setup

Note
Requires an Android device, SPA, and Windows PC, which are not included as 
part of the mapping solution.

2

1
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3
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2-6 Wireless Hardware Connection
A wireless connection from the MA8100A Signal Mapper to an Anritsu instrument facilitates 
coverage mapping in cases where the measured frequency band is outside of the 2.4 GHz 
Wi-Fi band. This wireless capability allows a wider range of movement for the user without 
being limited to the length of the USB OTG cable. Figure 2-2 shows an Anritsu handheld 
instrument (LMR Master S412E) connected to an Android device through a portable wireless 
router (not included). 

1. Anritsu Spectrum Analyzer (S412E)

2. Ethernet Cable (router to S412E connection)

3. USB cable (powering router from S412E or 
an external source)

4. Wireless Router

5. Laptop or PC

6. Android Device 

7. NEON Tracker

Figure 2-2. Spectrum Analyzer Setup for Wireless Connection

Note
Requires an Android device, a TP-Link TL-WR802N router, SPA, and Windows 
PC, which are not included as part of the mapping solution. The Anritsu instrument 
must have an Ethernet port or Wi-Fi capabilities. 

1

2

3
5

4

67
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2-7 Connecting the TL-WR802N Wireless Router
This section provides instructions to wirelessly control Anritsu’s handheld instruments using 
a phone or tablet and the Wireless Router, TP Link Model TL-WR802NTL-WR802N 
(2000-1752-R). This instruction applies to most Anritsu handheld instruments with Ethernet 
connection.

The following items are needed:

• Anritsu handheld instrument with Ethernet port

• 1 TP-Link TL-WR802N router

• USB-A to micro-USB cable (included with router)

• 1 Ethernet cable (included with router)

• Android Smartphone or tablet

Configuring the Wireless Router

Your router comes factory configured to work with Anritsu instruments. The router will come 
with a USB, a USB-A to micro-USB cable, and an Ethernet cable. Record the following 
information for future reference:

• SSID and wireless password. The default SSID is located on the bottom label of the 
router and is displayed on the Android device as shown in Figure 2-3.

• Admin password. This will be created during the initial setup. 

Note
It is recommended that the user upgrade to the latest firmware available on the 
Anritsu website. 

Figure 2-3. Default SSID of Router
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Connecting to the Wireless Router

Your TL-WR802N Wireless Router comes factory configured to work with Anritsu 
instruments.

1. Power off the Anritsu handheld instrument. 

2. Connect the USB and Ethernet cable from the instrument to the router. This will 
provide power to the router and network connectivity between the router and 
instrument. 

3. Set the Anritsu handheld instrument Ethernet settings as follows:

• IP Address = 192.168.0.50 

• Default Gateway Address = 0.0.0.0

• Subnet Mask = 255.255.255.0

4. Connect the laptop to the router via Wi-Fi (using the icons in the lower right system 
tray) using the SSID and pincode that are printed on the router label. These codes are 
unique for each router. For example:

• SSID = TP-LINK_39DE

• Password = 02850450

5. Open a browser on the computer and enter the URL address 192.168.0.50 to access the 
handheld instrument web interface.

Once the Anritsu handheld instrument is turned on, wait two to three minutes or until the 
router finishes booting up and is broadcasting its SSID. Enter the password when prompted 
as shown in Figure 2-4. The default Wi-Fi password can also be found on the label on the 
bottom of the router. 

Figure 2-4. Enter Password
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Recover the Factory Configuration

1. Connect the laptop to the router via Wi-Fi as described in Step 4 of 
 “Connecting to the Wireless Router” on page 2-6.

2. Open a web browser and enter the URL address tplinkwifi.net (or 192.168.0.1 is the 
router default IP address, which will be changed later in the procedure).

3. Log in to the router using the defaults:

• username: admin 

• password: admin 

4. Click Quick Setup.

5. Set the router as an Access Point and click Next until the Quick Setup is done.

6. Review the settings and then reboot the router using the on-screen Reboot button, then 
connect as described in the previous procedure.

7. Power on the instrument. The router’s light will blink green shortly thereafter. Once 
there is a connection to the instrument, the light will turn solid green. 

8. Verify the Anritsu handheld instrument’s IP setting is set to DHCP as described in 
your Anritsu instruments user guide. This will allow the router to assign an IP address 
automatically.
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Connecting to the Android

Once the Android device is wirelessly connected to the router:

1. Open a browser window.

2. Type tplinkwifi.net into the address bar.

3. Enter the default user name and password when prompted. The username and 
password info can be found at the bottom of the router. 

4. Select Operation Mode as shown in Figure 2-5 and ensure Access Point is selected. 

5. Touch OK when prompted and allow the router to reboot. 

Figure 2-5. Operation Mode/Access Point
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Connecting to the Spectrum Analyzer with a Smartphone 

1. Ensure mobile data is turned off and the phone is connected to the correct router. The 
mobile data setting button for the Samsung Galaxy S8 is shown in Figure 2-6.

2. Open a browser and enter the IP address of the instrument. 

The browser will load the Anritsu login page as shown in Figure 2-7 on page 2-10. In this 
example, the IP is 192.168.0.100.

Figure 2-6. Mobile Data Settings

Note
In cases where an instrument with Wi-Fi such as the MS2090A connects directly 
to a phone with hotspot enabled (without using a router), then mobile data can be 
turned on.
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3. Click “Login” at the bottom of the page. By default, there is no password required.

After the login page, the user can navigate using the available tabs such as Home, Remote 
Control, Capture Screen, Capture Trace, File List, Device Management, and Logout. 
Figure 2-8 shows the Remote Control tab and the spectrum analyzer display with channel 
power measurements.

Figure 2-7. Anritsu Handheld Instrument Login

Figure 2-8. Remote Control Tab
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2-8 Connecting to TRX NEON
This section describes how to connect the tracker to the TRX NEON App. 

1. Touch the NEON App on the smartphone as shown in Figure 2-9. 

2. Touch the three bar icon as shown in Figure 2-10.  

3. Power on the tracker and confirm the tracker’s green light is on.

4. Touch Anritsu Settings to access the smartphone’s Anritsu Settings as shown in 
Figure 2-11.

Figure 2-9. NEON App

Figure 2-10. Three Bar Icon

Figure 2-11. Smartphone Anritsu Settings
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In the Anritsu settings menu:

5. Touch and change Connection Type to Wi-Fi.

6. Touch Device IP Address and type the correct IP address. 

7. Touch Test Device Connection.

8. Verify “Status: Connected” is displayed as shown in Figure 2-12. 

To pair the device, initialize your location and perform signal mapping. Refer to “On-Site 
Mapping” on page 4-1.

Figure 2-12. Status Connected
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Chapter 3 — Site Planning

3-1 Introduction
The primary function of NEON Command is to create building models and view tracking logs. 
Adding building models allows for 3D tracking and also improves 2D tracking. This chapter 
provides the basic Site Planning process. Refer to the NEON Command website and follow 
the NEON Command procedures and menu interfaces to perform Site Planning.

3-2 Log In to NEON Command
Log in to the NEON Command page as described in “NEON Signal Mapper Software” 
on page 2-2. The login page opens when you launch NEON Command on your PC, unless you 
are already signed in. Use your registered email address and password to log in to the 
application. If you are using a Gmail address, you can alternatively click on Sign in with 
Google. 

Building Editor

The NEON Command Building Editor features let you name a building, add floors and floor 
plans, and edit the building outline and floor plans. Optionally, you can download any 
building updates made by another user.

Building Editor functions are accessed and performed the same way, whether you are 
entering information for a new building or modifying an existing building. If you just finished 
creating a building, NEON Command automatically opens the Building Editor and displays 
the Edit Building Details.

To save or discard your unsaved changes to the building data and exit the Building Editor, 
click Save or Cancel, then select the appropriate response in the confirmation dialog.

The Building Editor is also available in the NEON Signal Mapper app on your Android 
device.

Add Floors to a Building

After creating a building outline, you can give the building a name and set the number of 
floors in the building. Perform the following steps while in Building Editor mode. 

Note

Exiting NEON Command does not log you out. Next time you open the application, 
you will still be logged in and the login page will be bypassed. To log out of NEON 
Command, click your email address in the upper right corner of the screen and 
select Logout.
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Add a Floor Plan

You can attach a pre-existing floor plan to each floor in the building. If you don’t have the 
floor plan images that you need, do an online search of floor plans for your building. .

Edit a Building in Signal Mapper

Building details and floor plans can be modified in NEON Command on a PC and in Signal 
Mapper on your Android device. Signal Mapper gives you the additional ability to take and 
load pictures of physical floor plans if no floor plan image files currently available.

Edit building details or change floor plans with Signal Mapper. Use fingertip motions to 
resize and rotate the floor plan to make it fit over the building outline as shown in Figure 3-1. 

Saved building data is automatically uploaded to the cloud and becomes available to all users 
registered to the same NEON subscription. For information on how to keep building data in 
local memory only and prevent it from syncing with the cloud, refer to “Offline Buildings 
(Optional Feature)”.

Note

If no digital image of a floor plan exists, skip this section and use the Building 
Editor on your Android device to select the Replace Floor Plan From Camera 
function. This feature allows you to take pictures of a physical floor plan, such as 
an emergency evacuation plan if available.

Note

When saved, the building data is normally uploaded to the NEON Cloud Service 
and becomes accessible to all users registered under the same subscription.

However, if your subscription includes the option to create offline buildings, 
clicking Save for the first time on a newly created building will open a prompt 
asking if you want to save the building as Private (uploaded to your subscription) 
or Offline (not synced with the NEON Cloud). Once a building has been flagged as 
offline, subsequent saves will automatically overwrite the locally stored building 
data.

Figure 3-1. Building Editor Main Screen (Android Phone)
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3-3 Offline Buildings (Optional Feature)
The optional offline building feature lets you export a building outline and associated floor 
plans from NEON Command to a mapping package (.maps file) stored locally on your PC. 
This building data is not uploaded to the NEON Cloud. Instead, you can upload the mapping 
package later to an Android device without using the Cloud Service.

The offline building data may also be shared with users registered under the same or a 
different NEON subscription by making the mapping package available to them for import 
into their NEON Command application.

Export a Mapping Package

This function is available only if your NEON subscription has the optional offline building 
feature enabled through TRX Systems.

Offline buildings are deleted from NEON Command when you log out of your account. To 
restore the building, import the mapping package.

Import a Mapping Package into NEON Command

If an outline and floor plans already exist for your building in the form of a .maps file to which 
you have access, you can load this mapping package into NEON Command instead of creating 
the building from scratch. 

Unlike exporting, importing mapping packages does not require the offline building option to 
be enabled. This makes it easier to share building data with users under another NEON 
subscription where the feature is not available.

Upload a Mapping Package to Android Device

1. Connect the Android device to your PC over USB.

2. Open the external device in Windows Explorer and create a folder named “TRXMaps” 
in the top level directory.

3. Paste a copy of the mapping package (file extension .maps) into the TRXMaps folder. 

4. Open the Signal Mapper app on the Android device and the offline building will load. 
An “Importing Maps” message may display briefly.

Figure 3-2. TRXMaps Folder on Android Device
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Chapter 4 — On-Site Mapping

4-1 Introduction
NEON Signal Mapper integrates with the handheld spectrum analyzers to pull in signal data 
and place it on a map. The NEON Signal Mapper app includes a visualizer that displays the 
signal strength of a custom set signal on a floor plan image for real time visualization and 
debugging. This chapter provides the basic On-Site Mapping process. Refer to the NEON 
Signal Mapper website and follow the NEON Signal Mapper procedures and menu interfaces 
to perform On-Site Mapping.

4-2 Select the Building and Floor
1. Go to the building and floor where you want to start the coverage mapping session.

2. Open Signal Mapper on the Android device and log in to your NEON account. If you 
have not installed NEON Signal Mapper, refer “Registration and Installation” on 
page 2-1.

3. Enter the address of the building you want to map in the input field.

4. Select the floor number from the floor selector.

4-3 Pair the Tracking Unit and Android Device
The NEON Tracking Unit is a small, wearable device that collects inertial and pressure data 
used by Signal Mapper to calculate user location. It connects over Bluetooth to your Android 
phone or tablet.

Before pairing the tracking unit and the Android device, turn on the tracker by pressing the 
power button. The top LED blinks green (Anchor mode) when power-on is complete. 

NFC Touch Pairing

Touch the TRX logo on the tracking unit to the back of the phone to pair with NFC Touch 
Pairing. After pairing is successful, the top LED on the tracker will blink blue, indicating it is 
on and connected to NEON (Tracker mode). If Signal Mapper is not currently open, this will 
also launch the app.

For the most accurate position data, wear the unit facing front while tracking. Proceed to 
“Initialize Your Location with Signal Mapper” on page 4-2.

If your Android device does not have NFC, continue with the instructions below to pair and 
connect manually.

Note
The tracking unit is detectable within the first two minutes of power-on. If you do 
not complete the pairing in time, turn the tracker off and on, then try again.
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Tracking Unit Selection in Signal Mapper

1. Start scanning for nearby Bluetooth devices.

2. Select your tracker TRX_xxxx, where xxxx is the serial number of your tracking unit, 
then wait for the pairing to complete. 

NEON will place the best location estimate on the screen. For accurate calculations of 
heading and distance, you will need to initialize your location.

4-4 Initialize Your Location with Signal Mapper
Your location indicator in Signal Mapper consists of an error bound circle and avatar. Before 
initialization, your avatar is a red dot and is likely to move in a random direction. The 
location indicator is green when the tracker is initialized and locked onto your heading. The 
avatar then takes the shape of an arrowhead.

1. Stand at a location that you can readily identify on the floor plan.

2. Refer to the Signal Mapper menu and click the Check-in icon.

3. Drag and reposition the map to place the green pin marker at your actual location.

4. Apply the location correction and complete the check-in. Wait for the location indicator 
to reset your current position (red dot). 

5. Walk straight at least 10 meters to another recognizable location. 

6. Tap the Check-in icon to calibrate the heading and distance. The location indicator 
turns green and the error bound circle becomes small when a good heading lock is 
obtained.

Signal Mapper is now ready for tracking. To select the type of signals you want to map, go to 
“Select Signal Filter Type”.

Additionally, make sure your Anritsu test instrument is connected to Signal Mapper and is 
displaying measurement results before starting signal mapping.

4-5 Select Signal Filter Type
1. Refer to the Signal Mapper menu. 

2. Choose Anritsu as the filter type. 

3. Optionally apply a filter to the signal measurements displayed while mapping. Anritsu 
LTE is currently the only filter option available for Anritsu instruments. 

4. Select other optional Signal Mapper settings such as the color map applied to 
measurements, the display base map, and your name and color when viewing remotely.

Note
The location indicator does not immediately follow your movement after the first 
check-in. The indicator will follow your position after getting a heading lock from the 
second check-in.
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4-6 Channel Power Measurement
NEON Signal Mapper can collect channel power measurement data from all Anritsu 
handheld test instruments that support Spectrum Analyzer mode. Basic familiarity with your 
Anritsu test equipment is required.

Before performing in-building mapping, the spectrum analyzer must first be configured to 
measure signals. Knowing the anticipated signal strength and variation, potential presence of 
interfering signals, and noise sources should be used in determining analyzer settings. Refer 
to the instrument user manual for detailed instructions.

Connect the Spectrum Analyzer to Signal Mapper

Attach the Android device to the spectrum analyzer using the USB OTG cable to transfer the 
measurements into the NEON software as shown in Figure 2-1 on page 2-3. Alternatively, if 
the device has an Ethernet connection, you can enter its IP address on the Mapper Settings 
page. Refer to the Anritsu’s handheld user guide to connect to a network or directly to a PC 
using Ethernet connectivity.

Connect MS27101A-IBCM to Signal Mapper

Refer to the In-Building Coverage Mapper Hardware Quick Start Guide (10580-00470) for 
complete MS27101A-IBCM power-on and assembly instructions. 

4-7 On-Site Mapping
1. Tap the blue button to start Mapper mode. NEON will automatically detect and 

geo-reference sensors and signals as you move.

2. Walk through areas where you want to collect RF signal data. Signal strength is 
represented by a colored dot. A gray dot means no signal is detected at that location.

A timer is displayed on the screen while you are mapping. The latest signal reading is 
shown, updating every second. Also displayed are the signal type being tracked, the 
building floor, and bars indicating the strength of the heading lock. 

3. Display all signals of the selected type that have been scanned in the last 15 seconds. 

4. Optionally, change the signal type to change the type of signals displayed.

5. Stop recording signal data.

6. In the Mapping Finished dialog, enter a name for the log file, then upload map. 

The uploaded signal map can later be opened in the NEON Command application on 
your PC.

Other choices in the Mapping Finished dialog let you discard the map or continue mapping. 
Storing the map locally will create the signal map in the Android device’s local folder.

Note
If your location indicator becomes inaccurate, the phone will vibrate and Signal 
Mapper will stop collecting signal map data. If this happens, check-in at multiple 
locations until your avatar turns green. The app will then resume signal mapping.
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4-8 Signal Mapping in an Offline Building
This topic applies only to buildings flagged as offline when they were created and saved in 
NEON Command. Offline building data is not uploaded to the cloud and is available in the 
form of a mapping package only to users who have access to this file. Refer to “Offline 
Buildings (Optional Feature)” for more information.

All the tasks related to conducting an on-site signal mapping session in a private building, as 
described in the previous sections, apply to an offline building. The only difference is in saving 
the mapping data locally on the Android device instead of uploading it to the cloud.

When you are done collecting signal map data, tap the red button to stop recording. In the 
Mapping Finished dialog, enter a name for the log file. The signal map is saved to the phone's 
memory in the folder NeonSignalMaps.

4-9 Signal Maps Stored on Android Device
Signal maps that are saved locally on an Android device are stored in a folder named 
NeonSignalMaps. From here, the signal maps can be uploaded to the cloud at any time. 
Additionally, you can manually transfer map data collected in an offline building from the 
Android device to your PC without using the NEON Cloud Service.

Upload Stored Signal Maps to the Cloud

1. Upload Signal Maps from the Signal Mapper menu. 

2. Find the desired signal map log and select it, then Upload Selected.

3. Open the signal map in NEON Command.

Transfer Stored Signal Maps to a PC

1. Connect the Android device to your PC over USB.

2. Open the external device in Windows Explorer and open the folder named 
“NeonSignalMaps.”

3. Copy the signal map file (extension .sigmap) to the appropriate location on your PC.

4. Open the signal map in NEON Command.
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Chapter 5 — Signal Map Viewing and 
Reporting

5-1 Introduction
Measurement results with location data that have been saved in signal map logs can be 
displayed and analyzed on your PC using the NEON Command application. This chapter 
provides the basic Signal Map Viewing and Reporting process. Refer to the NEON Command 
website and follow the NEON Command procedures and menu interfaces to perform Signal 
Map Viewing and Reporting. 

5-2 Open a Signal Map Log
Open a signal map log from the File menu. The file may be stored locally or in the NEON 
Cloud. 

To open a single signal map previously uploaded to the cloud, select the log file from one of 
the folders created by date and click OK. 

Open a locally saved signal map, then navigate to the signal map log in the Open File 
Explorer window. NEON Command displays a map of the test area with a list of signals 
mapped in the log.

To visualize the signals on the map, go to “Generate a Heat Map”.

Figure 5-1. Select Cloud Log
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5-3 Create a Combined Signal Map
You can combine signal map data from different sources and display them together on the 
NEON Command screen.

1. From the File menu, open a Combined Signal Map.

2. Add Local or Add Cloud depending on where the signal map you want to add is located.

3. Navigate to the local signal map log in the Select Signal Map Explorer window, or to 
the cloud log in the Select Cloud Log window and select the file.

4. Add as many signal maps as you wish, then click Open.

5-4 Generate a Heat Map
When you open a signal map log in NEON Command, a list of all the signals that were 
detected and geo-referenced is displayed next to the map.

1. Select the signal type, then click on the individual signals you want to display. You can 
also click select all of them.

2.  Generate Map to display the data collected with Signal Mapper. The 2D image will 
appear similar to the one in Figure 5-2. 

3. View signal data collected on another building floor, 

4. You may optionally choose a different map type, such as a street view, 

5. The Layers menu lets you turn on and off the display of Building, Personnel, and Signal 
Mapper elements.

Figure 5-2. Heat Map Display in 2D
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6. To select color map options and other Signal Mapper or user interface settings.

7. Capture a screen shot of the current map display.

8. Display a 3D view of the signal map. 

Use the NEON Command Software to view the signal strength inside three levels.

5-5 Create Reports
After opening a signal map in NEON Command, use the File > Export menu function to create 
reports of measurement results, time, and location data contained in the log.

Figure 5-3. Heat Map Display in 3D

Figure 5-4. Three Levels in 3D
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CSV Report

Exporting to CSV format creates a zip folder of CSV files containing measurement data with 
time stamp and location for all the signals collected in the signal map. You can export CSV 
reports for the currently open signal map without first generating a heat map.

Image Report

Image reports consist of CSV-formatted files and a PNG image capture of the heat map. The 
CSV files contain all the measurement results and location data from the signal map.

iBwave Report

This feature creates reports in a format that can be imported into your iBwave application. 
The exported zip folder includes signal data and location files in CSV format, floor plan 
images, and .tab files that geo-reference the floor plans.

5-6 NEON Command Display Settings
You can control what data is displayed on the NEON Command screen as well as your 
viewing preferences. The following sections describe some of the more commonly used display 
options available in NEON Command.

Maps Menu

The Maps menu lets you select the base map tile type displayed in the map area of the NEON 
Command window. 

Figure 5-5. Map Tile Options
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Layers Menu

From the Layers, select or deselect display elements you want to show or hide. Expand each 
layer to see the list of individual display elements. 

Color Maps

Use color maps to set the display colors of dots representing the signal strength of 
measurements taken. Each of the user-specified ranges is associated with a different color. To 
edit an existing color map or create your own:

1. Select the color map to edit. 

2. Enter a name and select the measurement type.

3.  Add a Transition Point to set the transition value between each range. 

4. Add all the transition points needed to define the desired ranges.

5. Select a range or the minimum or maximum value. 

6. Select a color from the color palette. 

7. Repeat until all ranges in the color map have been assigned a color.

Figure 5-6. Layers Menu
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